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Jitterbug Plug-in User Manual

Preface

This user manual describes how to install and operate the Jitterbug scan-noise and drift
compensation plug-in (version 3.x) for Digital Micrograph.

The software is based on the full-length manuscript by Dr Lewys Jones and Prof Peter D. Nellst:

Lewys Jones and Peter D. Nellist. “Identifying and Correcting Scan Noise and Drift in the Scanning
Transmission Electron Microscope”. Microscopy and Microanalysis (2013) 19, p.1050-1060.

As this tool applies post-processing steps to experimental data, users should state explicitly
when such steps have been applied by citing the above paper such as:

“image scan-noise and drift was compensated using the Jitterbug software described in [1]".

Contact

Enquiries regarding sales, licensing, installation and operation of the plug-in should be directed
to:

support@hremresearch.com

For questions about the academic manuscript referenced above, please contact Dr Lewys Jones
at:

lewys.jones@tcd.ie

Copyright Statements

© Copyright 2015-2021 HREM Research Inc.
All rights reserved. This manual is protected by international copyright laws and treaties.
Unauthorized reproduction and distribution of this manual, or any portion of it, will be

prosecuted to the maximum extent possible and may result in severe civil and criminal penalties.

DigitalMicrograph is a trademark of Gatan Inc.
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When to use this Plug-in

The Jitterbug plug-in for Digital Micrograph is designed to correct some of the most common
image distortions encountered during atomic-resolution imaging in the scanning transmission
electron microscope (STEM) including scan-noise and image drift.

Scan-noise will often appear in images as ‘sliced’ or ‘torn’ atomic features and is also often
observed in Fourier transforms as white vertical bands streaking from low order spots (see
below). Alternatively, image drift can be observed as a deviation of known lattice plane angles
(expected to be 90° in the example below) or distortion of known lattice plane spacing.

= D: FFT of 003_STO_HAADF_25Mx

-
iz F: 003_STO_HAADF_25Mx o |[@] =

If your data includes these types of distortion then it may be possible to recover some or all of
the lost performance caused by scan-noise. Of course if the image is very heavily degraded it will
not be possible to compensate this entirely. Equally this plug-in cannot create resolution that did
not exist prior to the incorporation of scan-noise. For further information and some related
reading please see the reference given on page 2.
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Installation

Software Requirements

The following is a list of the software requirements necessary to run the Jitterbug plug-in:

e  DigitalMicrograph (GATAN™)

o USB Key Driver

° HREM Mouse Tool Plug-in (Free-ware downloadable from www.hremresearch.com)
° IPU Plug-in (Free-ware downloadable from www.hremresearch.com)

° Matlab MCR (Matlab Compiler Runtime)

Software Installation

Installing USB Key Driver

The user key driver should be installed by following the instructions given by the key driver
installer. The key driver installer can be found on our web site.

Installing Jitterbug Plug-in

The plug-in can be installed by drag-and-drop copy to the folder “Plugins” (The Pluglins folder
should exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglins folder,
Jitterbug menu commands will appear under “Jitterbug” menu.

Installing Mouse Tools

All the files relating Mouse tool plug-in can be installed by drag-and-drop copy to the folder
“Pluglns.” (The Pluglns folder should exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Plugins folder, the
Mouse tool will appear as an addition to the standard tools.

Installing IPU Plug-in

Jitterbug uses some functions based on the Intel” MKL (Math Kernel Library) provided by the IPU
plug-in. All the files relating the IPU plug-in can be installed by drag-and-drop copy. Please
consult the ReadMe file that comes with the IPU plug-in.

Installing Matlab MCR

The Matlab MCR should be installed by following the instructions given by the installer. The
Matlab MCR that is compatible with the Jitterbug can be found on our web site.
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Typical Workflow

Many of the tools included in this plug-in can be used independently as required. Where tools
depend upon using one or more features together this will be described in the sections that
follow. A typical user workflow for the correction of image scan-noise and drift is shown below:

® Scan noise compensation first requires the
coordinates of features in the STEM image to be
identified. Typically a feature will correspond to a
resolved atomic column.

Image peak-finding

® finding miss some peaks or find extra peaks the user
may add / remove these manually using the cursor.

Peak-finding
refinement

® Scan-noise compensation is performed in the
horizontal (fast-scan) direction and optionally the
vertical (slow-scan) direction

Scan-nosie
compensation

®  For drift measurement and compensation (optional)
Lattice base vector the lattice base vectors must be identified. These

definition directions will also be used for and image line-profiles
used.

® The user enters the expected (drift free) lattice

Drift measurem_ent parameters and angles and the image drift is
and compensation calculated and restored.

® If drift-correction has been used, the true image
Image magnification magnification can now be calibrated using the

re-calibration diffractogram.

®  After the corrections are complete image resolution
and signal-noise / signal-background ratios can be
Image property quantified.

quantification

The following examples will use the supplied example image to demonstrate the various steps.
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Plug-in Menu

The figure below shows the default menu for the Jitterbug plug-in:

ra IPU | Jitterbug I

(c) g2 Identify Peaks YA
Correct Second Signal »
Correct SI Data »
Settings...
Help »
About Jitterbug

In the menu, items that are currently unavailable are shown in grey. As you move through the
workflow, further options become available as needed.

Supported File Types

To begin, the user should have the file open within the Digital Micrograph workspace. To open a
file either open it from your computer or from within DM by going to File > Open.

The plug-in supports all image formats supported by DM, however, it is essential that the images
to be processed have received no image compression (such as JPEGs) and have had no pixel
resampling (either up-sampling or down-sampling).
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Peak Finding

Scan-noise compensation requires the peak positions of features to have been identified. This is
done using the menu: Jitterbug > Identify Peaks:

IPU | Jitterbug |

o) $88 Identify Peaks
——

-4

Find Peaks... ¥

Set Base Vectors

Correct Second Signal 4
Correct SI Data 4

Remove Translation Info

Settings...

Help »
About Jitterbug

Three options are presented for the peak-finding, manual target-separation, approximate peak-
separation search, or fully automatic.

Find Peaks X

Peak
© Determined size pX
@ Check sizes around m [9)4

@ Check all possible peak siz...
Use the peaks within ROI

If the exact separation between atomic features is known (in units of pixels) then this can be
input in the dialogue box and the software will search for features at this separation from one
another.
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If the separation is approximately known but not precisely, then the estimate can be entered
and the software will search around this range. If nothing is known, then a full search can be
performed, but this may be slow for very large images. There is no requirement for the features
to be in a regular array nor for any template to be specified. If time-series data is selected, then
peak-finding will be performed on the stack-average.

For the example image supplied the separation of features is approximately 19 pixels.
Alternatively, the option of ‘Check all possible peak sizes’ can be used. In this mode all possible
target-separations will be evaluated and the plug-in will try to automatically select the best
value. However, this option and the ‘Check seizes around’ option becomes slower and should
generally be avoided for images larger than 512x512 px.

For a large image, say >512x512 px., you can use a Rectangular ROI to select a search area to
accelerate a peak size search. When the ROl is present on the image, you may notice the check
box becomes active. A reasonably good peak size/separation can be estimated from relatively
small area that includes a several tens of peaks.

If ‘Check sizes around’ or option ‘Check all possible peak sizes’ is selected, then during the peak-
distance optimization stage an additional data output will be displayed:

;:;: D: Number of Peaks vs Peak Size =} =

2x104

1x104

§ ¢

Number of Peaks
T
g 8

30 35 40 45 50 55 60 65
Peak Size

Log of Diff of Peaks

30 35 40 45 50 55 60 65
Peak Size
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These figures show (top) the absolute number of possible candidate peaks found for different
search settings, and (bottom) the fitting used to determine the best plateau in the peak-number
data. This minimum point indicates the most robust size parameter and hence is the best choice
for the automated optimization step. The value from the optimization is then taken for the
automated peak-finding.

If for some reason the automated optimization is not able to produce an acceptable result (such
as very noisy data) then the user may use these figures to choose a reasonable manual estimate.
In many cases, an inflection point is a good candidate for the good peak size, even when the
minimum is not found.

After the peak finding is complete a new image will open with the results indicated by red dots:

= L: 003_STO_HAADF_25Mx

o TE 3

Here all features have been identified successfully, however the user can also add or remove
points manually. Adding or removing points is done using the HREM Mouse cursor:

P QA /Y O A MR Y

Selection Tool HREM Mouse Tool

To add additional peaks simply click one or more points on the image. These will appear as
numbered squares around the point clicked. When finished add the peak manually using the
Jitterbug menu:

10
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IPU | Jitterbug I Volume

3 888 Identify Peaks

- 4

Find Peaks... 3
Compensate Scan Noise... Remove Peaks

Set Base Vectors Add Peaks

Quantify Image Properties...

Correct Second Signal 4
Correct SI Data 4

Diagnose Instability Frequencies
Remove Translation Info

Settings...

Help 4
About Jitterbug

To remove peaks, use the same Mouse tool and click nearby the feature(s) to be removed. Again
select the “Remove Peaks” option from the menu and the feature closest to the position clicked
will be removed.

If you want to delete a cluster of peaks, you can use the rectangular ROI to specify these points
in addition to the mouse points.

The process of adding or removing peaks can be repeated as many times as needed until the
desired result is achieved.

11
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Scan-noise Compensation

Once feature positions are identified the menu option to “Compensate Scan Noise...” will be
available:

Identify Peaks

- Compensate Scan Noise...
Set Base Vectors
Image Distortion Correction...

Quantify Image Properties...

Correct Second Signal

Correct SI Data

Diagnose Instability Frequencies
Remove Translation Info

Settings...

Help
About Jitterbug

The dialogue box for scan-noise compensation options will then open.

Horizontal (Fast-scan Direction) Compensation

In this plug-in scan-noise compensation is achieved through comparison of image data with
neighboring rows. Of course in the original data these rows too may be themselves distorted and
so the restoration is performed iteratively. By default horizontal scan-noise compensation is on.

Horizontal (fast-scan direction) compensation
Number of iterations: |5
Peak regions only

Vertical (slow-scan direction) compensation

Keep translation info

12
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For larger images (bigger than 512x512px) it is recommended to use no more than five iterations.
Restoration performance improves only slightly beyond two iterations.

If you intend to go onwards to correct a second image signal or a spectrum-image volume, you
should select “Keep translation info”. This will store all the data to enable identical pixel shifts to
be applied a second time. If you do not need this you can un-check this box to slightly reduce
computer memory usage.

During the correction of horizontal scan noise the diagnosed probe offset plot will be displayed.
If the image magnification has been calibrated this will be shown in units of nanometers,
otherwise pixels.

”

ri- I Probe Instability Plot_5 of 5 o[22

0.154
Measured Instability
0.10 Estimated Instability

0.054

L MWJWJ”%WWA%MN

-0.051

0.0

Probe Instability (nm)
Q

-0.101

-0.151

o 2 4 6 8 10 12 14 16 18
Fast-scan Line Time (msec)

This distortion offset profile will be updated as each scan-line is processed and with each
iteration during the restoration. The figure will remain after compensation is complete showing
the final scan-line of the final iteration (5 in the above example). After the compensation is
complete you may close this figure if you wish as it is not needed by any of the onward
processing steps.

Vertical (Slow-scan Direction) Compensation

In the “Compensate Scan Noise” dialogue box, compensation of vertical scan-noise may be
selected as an option. In general this option should be left on (box checked) but there are certain
circumstances where this option should not be used.

This feature will attempt to locally re-order parts of the scan lines in the slow-scan direction by
sorting rows based on their intensity. Where atomic features are only just resolved (such as a
very close dumbells), and the nearest neighbor is along a near vertical direction, it may not be
possible to correctly identify this vertical scan-noise and the option should be un-checked.

13
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Fast Mode for Sparse Images

For images where the field of view is not filled with sample (such as nano-particles or samples
with an edge) it may not be necessary to scan-noise compensate the whole image. In regions
which do not contain atomic resolution information (and hence are not identified by the peak-
finding) no benefit will be observed upon this correction. In this situation a ‘fast mode’ may be
used which will aim to reduce the number of calculations made where possible to speed up the
restoration. To use this mode select the option “Peak regions only”.

After scan-compensation is complete the restored image will be returned in a new window with
a title that reflects this result.

Compensate Scan Noise - Display Options

The second tab of the ‘Compensate Scan Noise’ dialogue gives users the choice to generate extra
diagnostic data about the applied corrections. By default these are not needed but may be
useful for power users or debugging.

t-,-_- Compensate Scan Noise [d_hj

Control Display l

Horizontal shift
[Vl2p
[V] Histogram

Vertical shift (Before Horizontal)
V] 2D
[V] Histogram

Vertical shift (After Horizontal)
[vl2p
[V] Histogram

oK ] [ Cancel

Horizontal shifts that are diagnosed can be displayed as an image plot and also as a histogram.
The user may find it interesting to observe the ‘fast-scan’ direction streaking of the diagnosed
horizontal shifts. Users may for example take line profiles of this shift plot to observe the
distortions.

14
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-
;_ra-_' D: Horizontal Shift ;5\: E: Histgram of Horizontal Shift EI@

Similar figures can be displayed for the vertical (row-sorting) operation. As this is performed at
the start and end of the correction process, both a ‘before’ and ‘after’ version are displayed.

iz F: Vertical Shift (before Horizontal Restoration) té I Vertical Shift (after Horizontal Restoration)

15



Jitterbug Plug-in User Manual

Image Drift Correction

In practice image / stage / sample drift may be present. These drifts appear as a single overall
drift vector and may be present in any arbitrary direction; because of this no specific scan-
rotation need be prescribed when recording image data to use with this plug-in.

Setting of Base Vectors

To diagnose any variation from the expected crystal structure a pair of base vectors must first be
defined. This is done using the HREM Mouse tool. The process for this is to first click on an
atomic column that is to be used as the origin and then to click two points that define the ends
of the two basis vectors.

The points will be indicated by red squares and labeled 1,2 and 3. If you make an error and / or
wish to change the selection, simply remove the points (using Cntr+A / Cmnd+A and backspace /
delete) and identify new ones. After you are happy with the designation then select “Set Base
Vectors” from the Jitterbug menu.

16
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Identify Peaks

Compensate Scan Noise...

~ SetBaseVettors

Image Distortion Correction...

Quantify Image Properties...

Correct Second Signal
Correct SI Data

Diagnose Instability Frequencies

Remove Translation Info

Settings...

Help
About Jitterbug

This will generate an array of points (see below) to highlight repeat units of the identified
crystallography. Again the user should verify the result here is acceptable and if not repeat the
selection of the base vectors.

17
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= K: Scan Noise Corrected_003_STO_HAADF_25Mx

In general selecting base vectors that are lager will lead to a more precise measurement of the
properties of this repeat unit.

If the image used contains more than one crystal (e.g. a grain boundary) then either region may
be used and should yield the same result. If the sample contains a defect or some irregular
structure then the above process should be performed on the bulk region in the image.

18
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Description of Expected Geometry

After the base vectors have been defined as above the user may now correct for the image drift.
This is done from the Jitterbug menu selecting “Image Distortion Correction”:

Jitterbug | Volume

Identify Peaks

Compensate Scan Noise...
Set Base Vectors
Image Distortion Correction...

Quantify Image Properties...

Correct Second Signal 4
Correct SI Data 4

Diagnose Instability Frequencies
Remove Translation Info

Settings...

Help »
About Jitterbug

This will open the “Image Distortion Correction” dialog window which will show both the current
and target lengths and angles of the repeat unit identified by the base vectors:

= Image Distorton Correction
Target Current

Vector 1 Length: |47.4 (47 4 pixel)

Angle: |-7349 (-73.9 degree)

Vector 2 Length: |44.2 (44 .2 pixel)

Angle: |8_77 (8.8 degree)

[V Perform Comection
[V Crop Image
oK Cancel |

In this example data (strontium titanate [100] projection) the repeat unit should be square, that
is the two base vectors should be identical lengths and separated by 90°. The dialog window
shows the lengths to be different by around 7% and the angle between them to be only 83°. To

19
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correct this you may modify either the first or second vector’s properties or some mixture of
both. For this example vector 1 will be modified to match vector 2:

ri Image Distortion Correction 7&

Target Curmrent
Vector 1 Length: |44.2 (47 4 pixel)

Angle: |-81.23 (-73.9 dearee)

Vector 2 Length: |44.2 (44 2 pixel)

Angle: |8.77 (8.8 degree)

[V Perform Comection
[V Crop Image

oK

Two final options are presented for the user to choose: whether to perform correction and
whether to crop the image. The default mode is for both to be on (checked).

The distortion correction feature can be used to only measure the drift without correcting it.
This may be used for example to compare the raw and restored image results. The second
option is whether to crop the image after the correction transform.

The vectors used here could have been identified in the opposite sense (separated by 97°) and
would have yielded the same results.

Image Cropping

In general after drift correction the true scanned area will be slightly off-square (usually a
rotated parallelogram). If the user is interested in the shape of this image then cropping may be
disabled. For general use though this option should be left on and the plug-in will return the

largest possible square image suitable for further analysis. A comparison of these two results for
this is shown below:

20
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=

= 0: Distortion Corrected Image_Scan Noise Corrected 003... [ o || & |[ 52 |

In both images the same correction was applied but as expected with cropping a slightly smaller
field of view is returned.

Magnification Re-calibration

After drift correction an important warning message will be displayed:

DigitalMicrograph

'/'_—\\-. Image drift corrected, please re-calibrate image magnification.
‘&Y' (Microscope -> Calibrate Image From Diffractogram)

As a result of the previously asymmetric magnification (around 7% difference in vector lengths)
the magnification of the new image must now be re-calibrated. If this stage is ignored then any
measurements or scale-bars applied to the data may yield an error of a similar magnitude.

To calibrate the image magnification the spacing of a family of lattice planes must be known and
applied using the Digital Micrograph menu option “Microscope > Calibrate Image From
Diffractogram”. The difference between the original distorted data and the drift corrected result
can be seen if the image tags are inspected (right click on image > ImageDisplay...).

21
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Image Property Quantification

The Jitterbug plug-in contains tools to quantify the image properties before and after processing
to determine the level of improvement delivered. All these tools are accessed from the main
menu under: Jitterbug > Quantify Image Properties. Selecting this will open a dialogue box from
which you can choose the details to quantify:

Jitterbug | Volume

; Identify Peaks » L

Compensate Scan Noise...
Set Base Vectors

Image Distortion Correction...

Quantify Image Properties...
Correct Second Signal 4
Correct SI Data 4
(::_ . . ‘ 22 “
gz Quantify Image Properties )
Diagnose Instability Frequencies —
Remove Translation Info V' Resolution
Settings... Analyze |Peaks Simultaneously .Ll
Help > [V SNR/SBR
About Jitterbug OK | Cancel |
A

Resolution (Peak width)

The image resolution is determined by the fitting of one-dimensional Gaussian profiles to a large
number of peaks (atomic-columns) in a large number of directions (0.5° steps). The positions of
these peaks are taken from all across the field of view to give the fairest estimate possible.
Because of this resolution quantification can only proceed after peak positions have been
identified, if not this option will be ‘greyed out’ in the menu. In the ‘Quantify Image Properties’
dialogue box (shown above-right) three options are available for the resolution analysis as
described below:

Method Approach Useful for...

Useful when a fast estimate is needed (as
A single averaged peak is first | only a single fitting is performed).
“Averaged Peak” | computed and then Useful when the image SNR is extremely
guantified. low and the fitting of each individual peak
may not be trusted

All peaks are analysed
simultaneously as a function of
azimuth.

“Peaks
Simultaneously”

Most useful general setting for standard
computers and image qualities.

22
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“Peaks Each peak is analysed Useful for computers with little memory
Separately” sequentially. but will be slower.

The results of the second and third methods should be the same. A typical output is shown
below:

e

-

i K: Azimuthal (o[ @] =]
0.114
IAverage Angular Resolutionl
0.104
O.OB—J—AMR/\
0.084 ;_\
0.074
g 0.069
€
0.054
0.044
0.03
0.02
0.01
0.00 T T T T T T T T T
20 40 60 80 100 120 140 160 180
Azimuthal (direction)

If the image has its magnification calibrated then this display will be in units of nanometers,

otherwise pixels. In addition to this output the numerical results will be printed to the “Output
Window”:

Output X
Vectorl:( 13.01, -45.40), 47 .22
Vector2:( 43.67, 6.67). 44 17

Resolution:0.0886917 nm
SHR_mean:2.12
SBR_mean:0.60

4 . Results ; Notes . Debug [

Signal-noise Ratio & Signal-background Ratio (SNR/SBR)

The image SNR/SBR is calculated using many 1D line profiles through the data as described in the
academic manuscript. The positions and directions of these line profiles are defined based on
the based vectors set in the image (see above section on drift correction). If appropriate base
vectors are not set then the option to quantify SNR/SBR will be ‘greyed out’ in the “Quantify
Image Properties” dialogue box. The directions used will be along both of the set base vectors

23
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and also along directions bisecting these two (a total of four directions). The number of line
profiles in each direction is set in the settings dialogue (see below).

During the analysis a green line running through the specified directions will indicate where the
line-profiles are being taken from. With each line-profile a figure will show the analysis:

= AC: Peak Profile Analysis =0

<0.

Raw Signal

Signal Background

1

x 1004

The units here represent image counts and all numerical ratios for SNR and SBR are expressed
without units. Again these are also printed to the Output Window.

24
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Scan-noise Spectral Analysis

The Jitterbug plug-in can also be used to estimate the dominant distortions present in the EM
suite.

NOTE: this data should be used as a guide to EM suite diagnosis only and does not replace a full
suite analysis consolation.

To use this function the image must already have its peak features identified, otherwise this
option will be ‘greyed out’. From the main lJitterbug menu, select “Diagnose Instability
Frequencies”.

IPU | Jitterbug | Volume
388 Identify Peaks » X\ E

Compensate Scan Noise...

Set Base Vectors
Image Distortion Correction...

Quantify Image Properties...

Correct Second Signal »
Correct SI Data 4

Diagnose Instability Frequencies
Remove Translation Info

Settings...

Help »
About Jitterbug

Once running two windows will be displayed; the first represents the ‘distortion oscilloscope’
and shows the analysis being performed in real-time. The second window shows the average
distortion spectrum calculated so far. This will improve as the image rows are analysed and the
spectrum built up. An example is shown below where the dominant distortions are visible
around the 2kHz range typical of many sample holder resonant frequencies.

25
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The units on the distortion spectrum are relative and are not intended to indicate an absolute
measurement. The frequency scale will be accurately calibrated if the pixel dwell-time has been
correctly specified in the settings dialogue (see below). This can often be found in the image
‘tags’ (right click on image, select “ImageDisplay”).
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Processing a Second Image or a Spectrum Image

If you have a second image channel such as ADF and also ABF, or an image plus a spectrum-
image, recorded simultaneously, then it is possible to use the diagnosis from one signal to
correct the other. To perform this, select the relevant choice from the menu:

Identify Peaks

Compensate Scan Noise...
Set Base Vectors

Image Distortion Correction...

Quantify Image Properties...

- Correct Second Signal ~ »|  Scan Noise..
Correct SI Data 4 Image Distortion...

Diagnose Instability Frequencies

Remove Translation Info

Settings...

Help
About Jitterbug

After this is displayed you will need to select the “Reference signal” which has the translation
info stored, and the “Target signal” that you want to reapply the shifts to:

e

Reference signal: |1 Distortion Corrected Image_Scan Noise Corrected_003_STO_HAADF_25Mx v |

Target signal: |I: Distortion Corrected Image_Scan Noise Corrected_003_STO_HAADF_25Mx v |

Lok J[ concel |

After correcting scan-noise on the second signal / spectrum, you can subsequently follow the
same procedure to correct image distortion.

Remember the images / SI must be precisely simultaneous with the same pixilation for this
mode.
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Processing Time-series Data

Processing of time-series (multi-frame) data is supported in Jitterbug from version 2.0 onwards.
There are some extra options and settings for this and they are described in this section.

First the raw data must be realigned before processing to remove offsets from stage drift.,

If the front image is a time series, the average through the stack is automatically creates and

used to give precise peak-positions during peak-finding.

When correcting vertical or horizontal scan-noise, this is done within each slice of the data, using
the mean of the data as the reference. By default the average image will be shown after scan-
noise correction. The corrected individual frames can be shown by selecting “Show corrected

stacked image” in the ‘Correct Scan-noise options:

The time needed for this scales linearly with the number of images and may take several
minutes. To monitor the progress an additional window will display when processing multi-

frame data:

iz Compensate Scan Noise [ o

Control I Display I
Horizontal (fast-scan direction) compensation
Number of iterations: | 3

[ Peak regions only

Vertical (slow-scan direction) compensation

— - = s
Shopv corrected stacked image

[ OK ][ Cancel ]

Jitterbug v X
Compensate Scan Noise

Horizontal2

- = |
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Advanced Options (the Settings Menu)

Several of the features above can be tailored by adjusting the options in the Jitterbug settings
menu: Jitterbug > Settings. Options are saved when the menu is closed.

|| Fast-scan Line Smoothness Parameter: | 3.0

Image Quantification
SNR and SBR:
Number of Survey Line Profiles per Direction: | 5

Resolution:
Number of Survey Features (Peaks) @) I 50

All

Diagnose Instability Frequendes
Pixel dwell time: | 32.2 micro sec

Number of iterations: | 3

[ Bright field

Fast-scan Line Smoothness Parameter

Introduced in Jitterbug version 2.0, the user has more choice over the smoothing used on the
measured scan-noise offsets. Weak smoothing will only remove the most extreme outlier
measurements, while stringer smoothing reduces these further and should be used for the
lowest SNR raw data. The user can also enter a custom number; in most cases the ‘Normal’
smoothing strength is sufficient.

Image Quantification Options

Here options relating the image quantification can be set including the number of repeat line-
profiles per direction, as well as the total number of features to use in resolution analysis. The
pixel-dwell time should be input here to calibrate any distortion spectrum analysis as well as the
number of scan-noise correction iterations to make before outputting the frequency spectrum.

Bright Field Option

Here bright-field mode can be selected and ‘peaks’ will be defined as dark features rather than
bright.
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Quick Reference Guide

The Main Menu

Jitterbug is controlled from a single main
menu within DigitalMicrograph.

Jitterbug

Identify Peaks

Compensate Scan Noise...
Set Base Vectors
Image Distortion Correction...

Quantify Image Properties...

Correct Second Signal
Correct SI Data

Diagnose Instability Frequencies
Remove Translation Info

Settings...

Help

About Jitterbug

The commands in the Jitterbug menu are described below.

Command

Description

Identify Peaks
(see sub menus)

Identifies image intensity peaks (atomic columns)
automatically, and then allows Remove/Add peaks
manually using the HREM mouse.

Compensate Scan Noise..

Runs horizontal/vertical scan noise restoration

Set Base Vectors

It allows defining manually the base vectors on an
image.

Image Distortion Correctio

n...
Runs Drift Restoration using the Base vector
information

Quantify Image Properties

Image properties (resolution, SNR and SBR) will be
evaluated.

Correct Second Signal
(see sub menus)

Used to copy diagnosed scan-noise from one image
to another e.g. from ADF to ABF.

Correct Sl Data
(see sub menus)

Used to copy diagnosed scan-noise from one image
to a spectral volume e.g. from ADF to EELS SI.

Diagnose Instability Frequencies

Shows noise frequency profile.

Remove Translation
Info

Removes saved scan-noise diagnosis metadata to
reduce file size for saving.

Settings. ..

Some parameters will be altered here.
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Identify Peaks SubMenu Find Peaks...
Remove Peaks
Add Peaks
Component Description
Find Peaks... Identifies image intensity peaks (atomic columns)
automatically
Remove Peaks Removes peaks manually selected by using the

HREM mouse, or a Rectangular ROI.
(Launch this command after placing the mouse
selections.)

Add Peaks Adds peaks manually selected by using the HREM
mouse. (Launch this command after placing the
mouse selections.)

Find Peaks Dialog

The components of the dialog are described below.

Dlalog Find Peaks X

Peak
© Determined size jE] px

@ Check sizes around JE] px

@ Check all possible peak siz...

Use the peaks within ROI
[ o
Component Description
Peak size There are three options for peak identification:

Determined size: the peaks will be find using the
specified peak size. If there is a small Rectangular
ROI around a peak, its size will be shown in the box
as the Determined peak size.

Check sizes around: the peak size will be searched
around a specified size.

Check all possible peak sizes: the peak size will be
searched fully automatic.

Check box: Use the peaks within ROl
If there is a large Rectangular ROI that includes a
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several tens of peaks, the peak size search will be
done within the ROI. This will substantially speed up
the peak size search.
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Compensate Scan Noise Dialog

Control Tab iz Compensate Scan Noise @
Control IDisplay ]
Horizontal (fast-scan direction) compensation
Number of iterations: | 2
(| Peak regions only
Vertical (slow-scan direction) compensation
Keep translation info
[ OK ] [ Cancel ]
For a normal 2D image
i Compensate Scan Noise 5]
Control |Disp|ay |
Horizontal (fast-scan direction) compensation
Number of iterations: Iﬂ
(| Peak regions only
Vertical (slow-scan direction) compensation
Keep translation info
Time Series
Show corrected stacked image
[ OK ] [ Cancel ]
For a Time Series (3D image)
Component | Description

Horizontal (fast-scan direction) compensation

If checked, restoration along horizontal direction will
be done.

Number of iterations

Specifies a number of iterations of horizontal
restoration.

Peak regions only

Switches between whole pixels (area) or the pixels
within each peak area.

Vertical (slow-scan directi

on) compensation
If checked, restoration along vertical direction will be
done.
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If checked, scan-noise diagnosis is stored to be used
for correction of a second image or for S| data.

Time Series: Show corrected stacked image

If checked, a corrected individual frames will be
shown as a stacked image, as well as the averaged
image after scan noise correction.

Display Tab i~ Compensate Scan Noise [
Control Display
Horizontal shift
V] 2D
(V| Histogram
Vertical shift (Before Horizontal)
V2D
|| Histogram
Vertical shift (After Horizontal)
V2D
V| Histogram
[ OK ] [ Cancel
L )
Component \ Description
Horizontal shift
2D If checked, a 2D map of horizontal shift at each pixel
will be displayed in a separate window.
Histogram If checked, a histogram of horizontal shifts will be

displayed in a separate window.

Vertical shift (Before Horizontal)

2D If checked, a 2D map of vertical shift (before
horizontal compensation) at each pixel will be
displayed in a separate window.

Histogram If checked, a histogram of vertical shifts (before

horizontal compensation) will be displayed in a
separate window.

Vertical shift (After Horizontal)

2D If checked, a 2D map of vertical shift (after horizontal
compensation) at each pixel will be displayed in a
separate window.

Histogram If checked, a histogram of vertical shifts (after

horizontal compensation) will be displayed in a
separate window.
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Image Distortion Correction Dialog

Dialog

r;-_- Image Distortion Correction &J
Target Current

Vector 1 Length: |44.3| (44.3 pixel)

Angle: |9.23 (9.2 degree)
Vector 2 Length: | 47.3 (47.3 pixel)

Angle: |-73.7 (-73.7 degree)

(| Perform Correction

(V| Crop Image

[ OK ] [ Cancel

L A

Component

| Description

Vector 1

Length

Length of the vector 1. Measured value (current
value) is shown in the parenthesis. You can specify
the Target value.

Angle

Angle of the vector 1. Measured value (current value)
is shown in the parenthesis. You can specify the
Target value.

Vector 2: same as Vector

1

Perform Correction

If checked, information necessary to correct distortion
is estimated, and an image corrected for distortion will
be created.

If not checked, estimated distortion information is out
put in the Results window.

Crop Image

If checked, a rectangular part is extracted from the
distortion corrected image.
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Quantify Image Properties Dialog

Dialog i~ Quantify Image Properties Léj

[V| Resolution

Analyze [Averaged Peak V]
[V] SNR/SBR
[ OK ] [ Cancel ]
Component Description
Resolution If checked, resolution (peak size) will be estimated for
various directions.
Analyze Averaged Peak: Averaged peak profile is analyzed.

Peaks Simultaneously: Each peak is simultaneously
analyzed for each direction.

Peaks Separately: Each peak is analyzed separately
for each direction.

SNR/SBR If checked, SNR (signal-to-noise ratio) and SBR
(signal-to-background ratio) will be estimated.

Correct Second Signal SubMenu Scan Noise...

Image Distortion...

Component Description

Scan Noise... Used to copy the scan-noise correction from the
reference signal image to a target signal image.

Image Distortion... Used to copy the image-distortion correction from the
reference signal image to a target signal image.

Scan Noise Dialog Image Distortion Dialog

Dialog iz Correct Second Signal - Scan Noise Ii:_hj
Reference signal: [G: Distortion Corrected Image_Scan Noise Corrected_003_STO_HAADF_25Mx v]
Target signal: [C: STO_HAADF_Test_Image ']
OK } [ Cancel ]
Component Description
Reference signal Select the image with the stored scan-noise
diagnosis.
Target signal Select the new image to be corrected.
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Image Distortion...

Component

Description

Scan Noise...

Used to copy the scan-noise correction from the
reference signal image to a target Sl image.

Image Distortion...

Used to copy the image-distortion correction from the
reference signal image to a target Sl image.

Scan Noise Dialog Image Distortion Dialog

Dialog

=
iz Correct SI Data - Scan Noise 5|

Reference signal: [G: Distortion Corrected Image_Scan Noise Corrected_003_STO_HAADF_25Mx VI

Target signal: [A: Test VI

["] Trim frames

First frame: |1
Last frame: 'W

OK ] [ Cancel

Component

Description

Reference signal

Select the image with the stored scan-noise
diagnosis.

Target signal

Select the spectrum image to be corrected.

Trim frames If checked, will extract and correct only a subset of the
energy channels. Can be useful to reduce processing
time if only one part of the spectrum is wanted.

First frame The first channel to use when trimming.
Last frame The last channel to use when trimming.
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Settings Dialog
Dialog v Settings =2
Fast-scan Line Smoothness Parameter: 3.0

Image Quantification
SNR and SBR:
Number of Survey Line Profiles per Direction: | 5|

Resolution:
Number of Survey Features (Peaks) @ |50_
All

Diagnose Instability Frequencies

Pixel dwell time: W micro sec

Number of iterations: [2—
[ Bright field

[ OK ] [ Cancel
L 4
Component | Description

Fast-scan Line Smoothness Parameter
This parameter will control the smoothness of an
estimate of the horizontal (fast-scan) noise offsets. In
most cases the ‘Normal’ smoothing strength is
sufficient, while the user can enter a custom number.

Image Quantification

SNR and SBR:

Number of Survey Line Profiles per Direction:

Number of line profile with the high peak density to be
analyzed.

Four (4) directions (two base-vectors, and their sum
and difference directions) will be surveyed.

Resolution:

Number of Survey Features (Peaks)
Number of peaks used to estimate resolution (peak

width)
Diagnose Instability Frequencies
Pixel dwell time The pixel dwell time will be used to calculate the
highest frequency.

Number of iterations | Instability frequencies will be estimated after the
specified cycles of horizontal restoration.

Bright field If checked, a bright field image can be analyzed.
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